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INTRODUCTION
The Model 9840 is a CE compliant and versatile precision instrument intended for the
digital readout of strain gage sensors such as load cells and torque cells. Optical
encoders are also supported.
Here is a quick listing of its features:
•

OPTION ~ TEDS Template 33 Plug & Play Feature

•

Full bi-polar 6 digit display (±999,999) using two line, 20 character, vacuum
fluorescent display for clear, precise indication of measured quantities and limit
status.

•

No knobs or dials. No internal jumpers. All adjustment and calibration is done
using two user-friendly front panel touchscreens

•

Measure load and gross weight in pounds, kilograms, Newtons, PSI,
MegaPascals, kilo-pounds, kilo-Newtons, metric tons, mV/V, or grams. User
defined base area for PSI and MPa. Tare at any time. The sum of the loads on
both channels is also available.

•

Measure torque and gross torque in Pound-Inches, Newton-Meters, OunceInches, or mV/V. Tare at any time. The sum of the torques on both channels is
also available.

•

Capture the load peak and valley, display in pounds, kilograms, Newtons, PSI,
MegaPascals, kilo-pounds, kilo-Newtons, metric tons, mV/V, or grams. Reset at
any time.

•

Capture the torque peak and valley, display in Pound-Inches, Newton-Meters,
Ounce-Inches, or mV/V. Reset at any time.

•

Automatic identification of calibrated cells with auto-id feature.
Note: Auto ID is now Plug & Play. It does not require a power-cycle for a sensor
to be identified!

•

Calibration for cells using manufacturer’s milli-volt per Volt calibration factor, 6
point mass or torque and milli-volt per Volt, 2 or 5 point known mass or torque, or
internal precision shunt calibration. A back panel switch allows you to choose
between two values used for the shunt calibration so there is no need to open the
unit.

•

Analog output of any signal item (load, torque, peak, valley, Usum) with user
defined scale factor and offset. Large, buffered ± 10.00 volt output. The Model
9840 is standard with two Analog output channels. Two more Analog output
OPT
channels are available .

•

Remote operation using standard RS232 ASCII command set.
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• QUICK START
This section will help you get your Model 9840 set up and operating in just a couple of
minutes.
The back panel is shown below. You will need to make at least two connections here.
First be sure that the power switch is off (“O” symbol on rocker pressed in). Connect the
AC power line and plug it in.
MODEL 9840 BACK PANEL

Next connect a load or torque cell to the 9 pin female connector labeled “Load A”. You
should use the cabling supplied with your Model 9840 and Interface load or torque cell. If
you do not have a factory supplied cable see Appendix B for the recommended cell
connection.
You are now ready to turn on the power. Each time power is applied to the Model 9840
you will see two messages appear on the front display. For example,
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#

Message

1

Version X.Y.Z

This is the version number.

Serial # 12345

This is the serial number.

Option # 114236

This is the option number.

2

Touch Screen Vx.y.z

Meaning

This is the version number for the touch screen.

Each message will be displayed for about 3 seconds. After that the screen will start
showing the Main Menu where one of three modes (Run Mode, Setup Mode, Calibration
Mode) of operation can be selected, as shown below.
MODEL 9840 Main Menu

Run Mode will bring the unit to a screen with 4 displays depicting all 4 channels
simultaneously in their default state of Load A through Load D shown in pounds (Lb). The
example below shows Load A is 0.00116 mvV and Load B is -0.00399 mvV on the top
row. The second row of the display shows Load C is 0.00067 mvV and Load D is 0.01952 mvV. The “T” TEDSOPT annunciator indicates presence or non-presence of a
OPT
sensor. If it is on solid, a TEDSOPT sensor is attached to that specific channel. If
TEDS
OPT
sensor is attached. The “T” is not displayed when the
it is blinking a non TEDS
OPT
feature is turned off.
TEDS
To change the Item or Unit of any of the displays select the display to be changed on the
left screen (when selected there will be a red ring around it) press the Up/Down Item
arrows on left side of the right screen to cycle through the item options active for that
channel. The rightmost Up/Down arrow buttons on the right screen will cycle through the
units that can be used. For example, with the Item “Load A” showing you would see Lb,
kg, N, PSI, MPa, Klb, kN, t, mV/V, grams, and then back to Lb. If a Torque Cell is active
the unit options would be LbI, NM, OzI, and mV/V.
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The full list of Items with its respective units can be found in the table on page 11 in the
Run Mode section. If a torque cell is loaded on any channel, the display will show torque
rather than load for that appropriate channel. Channel A+B, as well as any other sum, will
only appear when both channels are attached to sensors of the same type: load or
torque.
Switching from a load to a torque cell and back will automatically reset Analog, and Filter
Window settings to zero and/or disabled it for that channel. See information under each
of these options for details on how they work.
MODEL 9840 Left Run Screen

MODEL 9840 Right Run Screen
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OPTION ~ TEDS TEMPLATE 33 (BRIDGE SENSOR) SUPPORT
The Model 9840 will now support TEDS Template 33 equipped sensors. It is a true plug
and play. No power cycle is required when a TEDS enabled sensor is attached. The
calibration data immediately gets loaded. The following units are supported from the
TEDS Template 33:
Physical
Physical
Cell
Measurand
Unit
Type
Case:
4
N
Load
5
lb
Load
10
Nm
Torque
11
oz-in
Torque
12
Pa
Load
13
psi
Load
14
Kg
Load
15
G
Load
All TEDS Template 33 parameters can be read through the touch screen or Serial. If the
annunciator is turned on, a “T” TEDS annunciator is displayed when the TEDS is turned
on. It appears in the top right of each display. It is on solid when a supported TEDS
Template 33 sensor is attached, otherwise it will blink. It is associated with the channel of
the selected item. If TEDS is turned off and AutoID is turned on, the annunciator will be a
“t”, indicating that Tag IDs can still be read. TEDS and AutoID are enabled/disabled
through the System Options menu on the touch screen or via RS-232 command.
Note: If TEDS and Auto ID are both enabled, a supported TEDS sensor will override
AutoID and the TEDS parameters will be loaded. Also, if TEDS is off and Auto ID is on, a
TEDS sensor can be used as an Auto ID sensor. This is because they both contain the 8
byte Tag ID.
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RUN MODE
Selecting Run Mode from the Main Menu will bring you to the Run Mode screen depicting
4 displays of channel information. A display is active when it is indicated with a red ring
around it. There is also a red rectangle center of the right screen which corresponds to
the relative position of that display to the other 3 on the left screen. Once a display is
active, the value can be manipulated using various control buttons visible on both
screens. Below is a description of how each of the available buttons operate.

Tare Button
The Tare button on the right screen sets the current load or torque to zero for the
channel associated with the currently selected display item. The Tare All button
on the left screen will do this for all four channels at once.

Reset Button
The Reset button on the right screen resets the current peak and valley for the
channel associated with the currently selected display item. The Reset All button
on the left screen will reset the peak and valley for all four channels at once.

Main Menu
The Main Menu button allows the user to return to the Main Menu, where the user
can navigate to the Setup menu, the Calibration mode, or back to the Run Mode.

Display Hold/Continue
When the Hold button is pressed during Run Mode operation, the readings on the
displays will hold/freeze. The “Data Streaming” identifier in the top right of the left
screen will go from green to red indicating that the display is not updating its
information in real time. Additionally the Hold button will change color from red to
green and will now say Continue. Pressing the Continue button will unfreeze the
displays and the Data Streaming identifier will switch back to green.

Item Buttons
The Item buttons allow navigation through the list of different items that can be
displayed. Not all items are available at the same time. Torque items will substitute
for Load items when appropriate. Sums are only available when cells on all
channels are of the same type (load or torque). Use the Unit buttons to change
the units that are used for the currently displayed item.

Unit Buttons
The Unit buttons allow navigation through the list of units that are available for the
item that is currently selected.
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The table below summarizes the unit options for each item. Whether the user sees torque
or load for each channel depends upon the cell type that was calibrated or selected for
that channel.
Load A/B/C/D
Peak A/B/C/D
(Load)
Valley A/B/C/D
(Load)
Gross A/B/C/D
(Load)
Channel A+B (Ld)
Torq A/B/C/D
Peak A/B/C/D
(Torque)
Valley A/B/C/D
(Torque)
Gross A/B/C/D
(Torque)
Channel A+B (Tq)
User Sums

Pounds, Kilograms, Newtons, PSI, MegaPascals, KiloPounds, Kilo-Newtons, Metric Tons, mV/V, grams.
Pounds, Kilograms, Newtons, PSI, MegaPascals, KiloPounds, Kilo-Newtons, Metric Tons, mV/V, grams.
Pounds, Kilograms, Newtons, PSI, MegaPascals, KiloPounds, Kilo-Newtons, Metric Tons, mV/V, grams.
Pounds, Kilograms, Newtons, PSI, MegaPascals, KiloPounds, Kilo-Newtons, Metric Tons, mV/V, grams.
Pounds, Kilograms, Newtons, PSI, MegaPascals, KiloPounds, Kilo-Newtons, Metric Tons, mV/V, grams.
Pound-Inches, Newton-Meters, Ounce-Inches, mV/V.
Pound-Inches, Newton-Meters, Ounce-Inches, mV/V.
Pound-Inches, Newton-Meters, Ounce-Inches, mV/V.
Pound-Inches, Newton-Meters, Ounce-Inches, mV/V.
Pound-Inches, Newton-Meters, Ounce-Inches, mV/V.
Either load or torque units, depending on the
constituent channels.

All these measurements are calculated by the Model 9840 at all times with torque
measurements acquired when a torque cell is attached to a channel and load
measurements acquired when a load cell is attached. The display just selects which item
you wish to see and what units are used to display or print this data.
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SETUP MODE SUMMARY
The table below summarizes the setup mode menus. Detailed information about each
individual item is presented in the following sections.

Setup mode
╠══════
║
║
╠══════
║
║
╠══════
║
║
║
║
║
║
║
║
║
╠══════
║
║
║
║
║
║
║
║
║
║
║
║
╚══════

>User Data Entry
╠════════

>>Base Area Entry → Channel

>Analog Output
╚════════

Channel → Source → Units → Full → Zero.

>Sensor Select
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╚════════

>>View Calibration on Channel A
>>View Calibration on Channel B
>>View Calibration on Channel C
>>View Calibration on Channel D
>>View Sensor Data → Sensor
>>Select Sensor Data → Channel → Sensor
>>Delete Sensor Data → Sensor
OPT
>>View TEDS
→ Channel

>System Options
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╠════════
╚════════

>>Auto Identify
>>AutoID Annunciator
>>Auto Zero Channel → Channel
>>Com Address
>>Com Baudrate → Baudrate
>>Com Line Feed
>>Retain Tare
>>EOT Char
OPT
>>TEDS Enable
>>Auto Tare
>>Serial Cmd Select → USB/Serial

>Display Options
╠════════
╠════════
╠════════
╠════════
╚════════

>>Filter Select → Type → Level
>>Filter Window → Channel → Unit → Value
>>Decimal Select → Channel
>>Count by Select → Channel → Increment
>>Select User Sums → Sum → Channel Select

SETUP MODE
Setup mode is used to change the setup of the Model 9840. To enter setup mode press
the Setup Mode button from the Main Menu Screen.
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MODEL 9840 Setup Screen

For this menu and its sub-menus, the down button navigates forward through the list, and
the up button navigates backwards.
To exit from setup mode and return to the Main Menu press the Back button for each sub
menu that has been entered, or just hit the Cancel button once. When you are entering
numerical data or selecting options from a sub-menu the Back button will back you out to
the previous menu/sub-menu without making any changes. The Continue button enters
you into the displayed sub-menu option or, following a data entry, advances you to the
following input screen.
The main Setup Mode menu contains the following entries which will be described in
detail in the following sections.
•
•
•
•

•

> User Data Entry -- allows you to set any common math options such as the base
area used to display load in PSI in percent.
> Analog Output -- is used to select the source and scaling for the standard analog
output channel.
> Sensor Select -- Lets you manually view current or set new load/torque cell
calibration data with each channel, view/delete saved calibration data, and view any
TEDS OPT data.
> System Options -- contains entries to enable or disable automatic sensor
identification and annunciation, enable or disable automatic load or torque zeroing, set
the serial communications address, baud rate, line feed, serial options and
preference, and choose whether or not to retain the most recent tare value through
power down and auto tare while at zero value.
> Display Options -- lets you choose the filtering that is applied to the load or torque
measurements, an optional window of data incrimination on which to turn the filter off,
the number of decimal digits that are shown on the display and on the print, the
channel count by values (1, 2, 5, 10, or 20), and the user sums setting.
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Entering Numerical Data
At times you will need to enter numerical data into the Model 9840. The method is
consistent in all cases. The keypad which is always present on the right touch screen
(except the Run Mode) will be used to type a number into the left screen when prompted
to do so. Hitting a number “0-9” on the right screen will make it appear on the far right of
the number entry box on the left screen. Any new numbers entered will push previous
digits to the left. Hitting the decimal point “.” will place it at the far right of the number, and
hitting the negative sign “-“ at any time will toggle the sign of the number. Cancel will
bring you back to the main menu screen. Backspace will delete the previous digits typed,
including the decimal, from the most recent entry and on until the entry box is empty.
Clear will delete all existing characters currently occupying the entry box. Enter will store
the number and either save it or bring you to the next part of the setup, depending on
what kind of data is being entered.
Note: While the left screen has a numerical entry box present, the button normally called
“Continue” changes in size and becomes a second “Enter” button that behaves the same
way as the Enter button on the keypad screen.

MODEL 9840 Keypad Screen

Entering Alphanumeric Data
When entering data into an entry box that accepts both numbers and letters, a keyboard
will appear on the right screen. This allows the user to use any alphanumeric string as the
serial number. The Backspace, Clear and Enter, buttons all function in the same ways
as described for the keypad screen. There is also a Shift button that toggles all keyboard
letters between upper and lowercase and a Space button.
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MODEL 9840 Alphanumeric Screen

>User Data Entry
This menu is used to enter numerical constants used by the math options. These
constants are listed in a submenu that works exactly like the main setup mode menu.
Typical items in this submenu are:

>>Base Area Entry
This is the area in square inches that is used to calculate load in pounds per square
inch (PSI) or Mega Pascals (MPa). A different area can be set for all four channels.

>Analog Output
This menu is used to set up the standard analog output. Instead of a submenu there is a
series of selections. Pressing Back at any time will step you back to the previous setup
entry where it can be edited or accepted once more with the Continue button. Setup data
will only be saved when the setup is finished. Note that when you change a cell type (from
load to torque or back again) these settings must be reset for the new cell.
1. Channel: -- This asks the user for the Analog Output channel. By default, A and C
are selectable. These channel designations do not prevent you from using any source
item with the selected Analog Output channel; using Load A with Analog Output C is
possible.
2. Source: -- This entry allows you to scroll through a list (Using the up and down
buttons) to select the source of the data that will drive the analog output. The
standard list will include load or torque, peak, valley, gross, A+B/C+D and the four
user sums (All summed items options, will only appear only if the cells on the summed
channels are of the same type).
3. Units: -- This entry allows you to scroll through the list of available units for the data
source you have chosen in the previous step.
4. Full -- This entry specifies the value of source data (in the selected units) that will
cause the Model 9840 to output positive full scale analog voltage (+10.0 volts).
5. Zero -- This entry specifies the value of source data (in the selected units) that will
cause the Model 9840 to output zero analog voltage (0.0 volts).
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>Sensor Select
This menu is used to view, select, and delete sensor calibration data on a specific
channel or browse through the list of load and torque cell calibration data stored within the
Model 9840. It also allows viewing of TEDS data on a selected channel.

>>View Cal on Ch A/B/C/D
The first four menu options allow the user to view the calibration data on the specified
channel. The data will populate a scrollable list navigable with the up and down arrows.

>>View Sensor Data
This option allows the user to view any saved sensor data on the unit. After selecting
the option, the user can scroll using the up and down arrows to find the serial number
of the data they wish to view. Upon selection, the data of the selected sensor will
populate a list similar to the above option

>>Select Sensor Data
This option allows the user to change the calibration data a channel is currently using.
The user will be asked to scroll to find the channel they wish to change the data for,
then the sensor serial number of the data they wish to use.

>>Delete Sensor Data
The unit allows up to 32 individual sensor data to be saved. If one needs to be deleted,
this option allows the user to scroll to select a serial number of the data that they wish
to be deleted.
Note: There is no double conformation or undo feature while deleting a sensors data.
Once a sensor serial number has been scrolled to and visible on the left screen hitting
the Continue button on the left screen or Enter button in the right will delete all stored
information for that sensor.

>>View TEDSOPT
After selecting a channel, a list of the TEDS data on that channel will be displayed.
The unit will show the user both the Basic TEDS and TEDS33 if the device is attached.
Otherwise, the unit will tell the user there is no TEDS on this channel.
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>System Options
This menu contains some system wide parameters that are seldom changed. These
parameters pertain to how the Model 9840 reads and interprets data as well as how it
communicates with a connected computer via the USB or RS232 Serial port on the back.

>>Auto Identify
This allows you to turn automatic cell identification on or off. AutoID can be left in the
“On” state even if it is never used, without adversely affecting the Model 9840 normal
operation. In order to use this function you must either have an AutoID equipped cell
or use an in-line auto-id module attached to your cell cable. If the TEDS OPT is not
included or is turned off, a TEDS enabled sensor will be treated as if it was an AutoID
sensor. This is because they both contain an 8 byte Tag ID.
Note: If the TEDS OPT is included and set to “On”, it will override Auto Identify when a
OPT
sensor is attached!
supported TEDS

>>AutoID Annunciator
This allows you to turn the AutoID Annunciator “t”, seen in the top right corner of the
four displays of the Run Mode screen, on or off. When on in conjunction with AutoID
the “t” will blink until an AutoID equipped cell is attached, at which point the “t” will go
solid.
Note: The TEDS OPT “T” annunciator will override the auto-ID annunciator for both its
blinking and solid states if TEDS is enabled. If an AutoID is attached during this case
the blinking “T” will still turn to a solid “t” to indicate it as an AutoID and not a TEDS.

>>Auto Zero Channel
This menu lets you enable or disable auto zeroing for measurements on any channel.
When enabled, this function will tare the load or torque to zero any time that it has
remained within 10 counts of zero on the display for 10 seconds.
Note: The 10 count value follows the decimal point setting found in the Display submenu. If a channel is set to 3 decimals the 10 count will be 0.010 (Units) similarly a
decimal setting of 4 will incur a count below 0.0010 (Units).

>>Com Address
This item allows you to set the address of this unit used for the Serial commands.
Valid values are 001 through 254.

>>Com Baudrate
This sets the baud rate for the RS232 ASCII command set. Available values are: 300,
600, 1200, 2400, 4800, 9600, 19.2k, 38.4k, 57.6k, and 230.4k. If communications are
done over USB the baud rate is set automatically rendering this setting irrelevant.

>>Com Line Feed
This controls whether a line feed is added to each carriage return that is sent out by
the Model 9840 when the Serial commands are being used.
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>>Retain Tare
This controls whether the most recent tare value is retained through power down of
the unit and used again immediately on power up. Switching “On” this setting will
retain the tare on all channels.

>>EOT Char
The End Of Transmission Character is a non-visible character (hexadecimal 0x04)
that is sent at the end of each response by the unit to a Serial command. The
character is sent after the last carriage-return line-feed is returned by the unit with just
one exception: when the user is viewing channel values with the Serial command
@123V(item)(unit)(repeat) … and sets the value of repeat to 2 (streaming output), the
character is sent immediately prior to the streaming output that the unit will send. The
user can turn this option on or off.

>>TEDS OPT Enable
If TEDS option is enabled, this menu will turn TEDS mode on or off. When on, a
TEDS33 enabled sensor will automatically load its calibration information into the
M9840 after attachment.

>>Auto Tare
The Auto Tare can be turned on or off in this menu. When on, it will perform an
automatic tare when an AutoID or TEDS enabled sensor is attached.

>>Serial Cmd Select
The source of serial commands can be toggled in this menu. The user can select
RS232 or USB.

>Display Options
This menu contains options that effect how cell data is treated for displaying purposes on
both touch screen and communication terminal window.

>>Filter Select
There are two types of filters available on the Model 9840: Type I, and Type II. Type I
filters are good for removing most kinds of noise but may leave some jitter on the end
digits. Type II filters are more advanced and are optimized for the typical industrial
environment. Both filter types allow you to select from 4 levels of filtering with Level 1
being the least filtering and Level 4 being the most filtering.
The settling time for each of the 4 levels of filtering is shown in the table below
Level
Settling Time (seconds)
Read Rate (per second)
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1
<1
60

2
2
60

3
10
30

4
30
10
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>>Filter Window
This option allows you to enable and set, or disable, a window to be used to turn the
filters on or off. If there is a sudden change in the measurement that exceeds this set
window, the filter is temporarily turned off to allow the displayed reading to correct itself
with the actual reading. This enables the user to see the sudden change in measured
data rather than being filtered out.
To turn a window on for a specific channel, use the Continue button to progress
through the different steps. First select the channel you wish to add a filter window
to, and choose to turn “On”. You will then be asked if you wish to use the
previously saved window value (0.0000 Lb or LbI default for Load/Torque cell).
“Yes” will complete the setup with the displayed value, save it and exit you out of
the filter window setup. “No” will advance you further, in order to enter a new
value. Select the unit first then the numerical value. Hitting either Enter button will
complete the filter window setup with the newly set value.
To change the window, simply repeat the steps above. Instead of 0 and Lbs or LbI
on the “old window” display, you will see the most recently entered value.
Note that changing a cell type on a channel will automatically disable the filter
window for that channel, reset the units to Lb or LbI, and set the window value to
0. The window must then be reset and re-enabled by the user.

>>Decimal Select
This lets you set the maximum number of digits to the right of the decimal, for each
channel, that are displayed or printed for any of the item selections. When large cells
are selected the number of decimal digits shown may be limited, for example a 100 Lb
cell will allow 3 digits, while a 1000 Lb cell will only allow 2 digits. Also, if a number is
too large to fit on the display some decimal digits may be dropped (the display will
“auto-range”).

>>Count by Select
This allows you to choose the smallest unit of counting for the display of the chosen
channel item. Counting by choices include: 1, 2, 5, 10, and 20.
Note that the operation of the analog outputs and the limits is not effected by the
settings of “decimal point” or “smallest count”. Thus if you set a limit to be activated at
10.001 Lbs, and have “smallest count” set for 20, the limit is activated at 10.001 Lbs
even though the display is only showing 10.000.

>>Select User Sums
This setting provides up to four different User Sum combinations: Usum1, Usum2,
Usum3 and Usum4. These combinations can be used as an item selection with a user
designated unit. Each User Sum is any combination of the four channels summed
together and displayed on the touchscreen, or serial terminal.
Note: These sums will only appear in the item lists if all selected channels for that Sum
are of the same cell type (Load or Torque).
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CALIBRATION MODE SUMMARY
The table below summarizes the Calibration Mode menus. Detailed information about
each individual item is presented in the following sections.

Calibration mode
╚══════

Cal. Password
╠═════
║
║
╠═════
║
║
║
╠═════
║
║
║
╠═════
║
║
║
╠═════
║
║
║
╚═════

Cal Check
╚═══════════
Two Point mV/V
╚═══════════
Six Point mV/V
╚═══════════
Two Point Data Cal
╚═══════════
Five Point Data Cal
╚═══════════
Shunt
╚═══════════

Channel
Channel → Cell Type →
Calibration Steps
Channel → Cell Type →
Calibration Steps
Channel → Cell Type →
Calibration Steps
Channel → Cell Type →
Calibration Steps
Channel → Cell Type →
Calibration Steps

MODEL 9840 Calibration Mode Password Screen

Once past the password screen, the Calibration Mode Menus will appear and have the
same structural layout as the Setup Mode Menus.
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CALIBRATION MODE
This menu is used to access all methods of calibration that are supported by the Model
9840. Selecting Calibration Mode from the Main Menu Screen will bring up a password
entry Screen for the left screen (see above) and an alphanumeric keyboard for the right
screen. Successful key in of the password (888) followed by either of the Enter buttons
will bring up a sub-menu which offers a calibration check for one channel at a time, and
various cell calibration options to select from. No matter which calibration style is
selected, all calibrations will start with the same basic question before diverting to its
unique calibration process. These common setting include, in this order: channel, cell
type, serial number (manually entered by user), current month, day and year, excitation
level (5.0V or 10.0V), unit and lastly the rated load of the cell.
If you are re-calibrating a cell, the Model 9840 will recognize it using either the AutoID or
a manually entered serial number. Any time you overwrite existing cell calibration data
you will first be warned with the “Overwrite Data?” message. Pressing enter will proceed
with the overwrite; pressing Back will undo the serial number entry and prompt the user
for a serial number again. Pressing either Cancel button with exit you entirely from the
calibration menu back to the Main Menu Screen. Both the Back and Cancel button will
abort the calibration process ad no data will have been saved. Another method of
overwriting existing data is to delete the sensor first in the Setup – Sensor Select menu,
and then perform a new calibration under the same sensor serial number.
If a cell with a new serial number (or new AutoID) is calibrated the data is added as a new
entry in the cell list.
Cells should be calibrated on the channel of which they are intended to be used on, but
that does not prevent a user, if they so choose, from selecting a sensor calibrated on
channel A and using it on channel D, for example.
If TEDSOPT is enabled and a TEDSOPT sensor is plugged into a channel, the user will not
be allowed to calibrate that channel.
Note: All calibrations can be performed using positive or negative values! For multipoint
calibrations this will allow for nonlinear calibrations across zero. The sign of a number is
changed by pressing the “-” button during number entry.

>>Cal Check
Selecting this item will run a calibration check on the cell attached to the selected
channel. The Model 9840 will measure the shunt value of the cell and compare it to
the shunt value that was recorded when the cell was last calibrated. It is important to
ensure that for this check to be accurate on all non AutoID and TEDSOPT enabled
devices, the same cell that was used to perform the calibration matches the cell serial
number assigned to the channel being checked. After the check is complete, the rated
load or torque and last calibration date for the cell are displayed followed by the
currently measured shunt value and the shunt value that was recorded when the cell
was calibrated.
Note that the Model 9840 has a switch on the back panel that allows you to select
either a 30K shunt or a 60K shunt. Be sure that this switch is set correctly for the cell
that you are using.
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Since this shunt check electronically applies approximately half the rated load or
torque, it is important that the cell is not loaded when this check is run. If you see the
“Cell Overloaded” message, remove any load or torque on the cell and try the check
again.

>>Two Point mV/V
This calibration options is used to calibrate a cell using the manufacturer’s milli-volt
per Volt calibration factor (the second point of a two point calibration that automatically
sets the first point at zero). After completing the basic questions that are commonly
asked in all the calibration styles for the Model 9840, the final question is specifically
related to the two point mv/V cal process. The user will be prompted to enter the millivolt per Volt cal constant (usually listed on the load cell calibration certificate), that
information combined with the rated load entered earlier make the second point. The
now two points together will determine the linear line of travel for the entire range of
the cell. The cell should not be under load or torque when this calibration method is
used since a shunt value will be measured and recorded for later use with the “Cal
Check” feature described above. The final “No Masses Ready” or “No Torque Ready”
message screen is intended to remind you of this fact. Hitting Enter will finalize the
entries just made, and a calibration will be performed. Once complete the user will be
able to review the calibration results listed in the same manner as the “View Cal”
selection under the Sensor Select menu within the Setup Mode.

>>Six Point mV/V
This calibration process is a series of six milli-volt per Volt points with corresponding
masses or torques (usually listed on the load cell calibration certificate). After
completing the basic data entry for the Model 9840, it will begin a series of entries for
mass and milli-volt per Volt starting with, “Mass value 1” and “mv/V value 1”. Typically
these first values entered are always zero since the 6 point calibration process does
not automatically set the zero point as it does in the two point cal. Going forward it will
perform a piece-wise linear interpolation between equally spaced adjacent points. The
mass values are auto filled based off the total rated load entered earlier in this
calibration process, the user can adjust these values if needed. Following each mass
value entery a milli-volt per Volt value will be entered, creating a new point.
The cell should not be under load or torque when this calibration method is used since
a shunt value will be measured and recorded for later use with the “Cal Check” feature
described above. The final “No Masses Ready” or “No Torque Ready” message
screen is intended to remind you of this fact. Hitting Enter will finalize the entries just
made, and a calibration will be performed. Once complete the user will be able to
review the calibration results listed in the same manner as the “View Cal” selection
under the Sensor Select menu within the Setup Mode.

>>Two Point Data Cal
This calibration option is used to calibrate a load or torque cell using known masses or
torques. After getting through the basic data entry described above, you are then
prompted to enter the value of the first mass or torque (typically a “no load” zero
value). The “Mass 1 Ready?” or "Torque 1 Ready?" message will wait while you apply
the mass or torque value entered in the previous step. Once applied hitting Enter will
command the Model 9840 to take its reading and will display the “Reading...”
message for about 10 seconds. During this time it is important that the masses or
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torque are not disturbed since all the readings taken are averaged together to obtain
the calibration data. The second mass/torque is then entered and applied to the cell,
the Model 9840 will auto fill in this value based off the previously entered total rated
load of the cell and the amount of points the calibration requires. This auto filled value
is completely adjustable. Once all points are read, a "No Masses Ready?” or "No
Torque Ready" reading is also required. During this reading, a shunt check value is
recorded. It is essential that the cell not be under load or torque when this step is
performed.

>>Five Point Data Cal
Similar to the Two Point Data Cal above, this calibration option is used to calibrate a
load or torque cell using known masses or torques. The process will be the same as
the Two Point Data Cal but with added point measurement readings to total five. One
of the readings, usually the first, should still be zero and at the end of the point
measurement process a shunt check is performed designated by the "No Masses
Ready?” or "No Torque Ready" screen appearing.

>>Cal by Shunt Val
This item is used to calibrate a cell using the manufacturer’s shunt calibration factor
expressed in pounds or pound-inches. You will be asked, after the basic data
described above, for the shunt calibration constant. The Model 9840 will then
automatically perform the shunt calibration of the cell using its internal precision shunt
resistor. Note that there is a back panel switch that allows you to select either a 30K
or 60K resistor for shunt measurements (see Appendix B for a circuit diagram). Be
sure to select the appropriate value for your cell. During this calibration the
“Reading...” message will be displayed. Do not disturb the cell while it is being read.
Like all the calibrations when a shunt check is performed, the cell should be free of
load or torque during this calibration.
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Digital Inputs
There are 4 digital inputs available on the Model 9840. They are accessible on the Digital
I/O connector on the back panel (pins 9 - 16). These inputs are individually opto-isolated
and include current limiting resistors. An input voltage anywhere from +4 to +22 volts DC
may be used to obtain the “on” state. See Appendix B for a full description of the Digital
I/O connector.
If you do not require isolation for your application you can use the +5 or +12 volt and GND
available on the Digital I/O connector (pins 24-26).
These 4 inputs are called IN1 through IN4 and have the following standard functions:
Functions may be assigned to these inputs by custom programming at the factory.
All the features and settings of the Model 9840 can be accessed remotely using the
Remote ASCII command set. These commands fall into three groups: those similar to
the Run Mode touchscreen commands; similar to the Setup Mode touchscreen
commands; and similar to the Calibration Mode touchscreen commands.
Communications can be established via RS232 protocols through the serial port on the
rear panel of the unit, or via USB communications through the USB port on the rear panel
of the unit in conjunction with the USB driver installed on the host PC. The commands
and command formats are the same for each method of communications.
Pinouts for the RS232 serial port communications are listed in Appendix B of this manual.
For older computers, USB communication may require the installation of the USB driver
located on the CD-ROM that accompanies this product. If the host PC can communicate
with the Model 9840 via USB, no driver is needed.

USB Driver
If the host PC cannot communicate with the Model 9840 via USB, install the USB driver
that accompanies this product on CD-ROM. To install the USB Driver, place the CD in
your CD-ROM drive. Select Run from your Windows Start menu. Type
D:\USB_Driver\CDM_Setup.exe (“D” or the corresponding CD-ROM drive letter for your
computer) in the box and hit Enter. You will be notified when the driver has finished
installing.
If no CD-ROM was received, download and install the USB driver from
http://www.ftdichip.com/Drivers/VCP.htm. You need to download and install driver version
2.04.06 or higher. Click on the download link 2.04.06 listed next to Windows XP and
follow the download and install instructions.

Communications Settings
The Model 9840 supports remote operation using a standard Remote interface consisting
of ASCII characters and terminal emulation software package such as HyperTerminal or
ProComm. The baud rate for the Model 9840 is in “Com Baudrate” within the Systems
Options of the Setup Menu. Supported rates are 300, 600, 1200, 2400, 4800, 9600,
19.2k, 38.4k, 57.6k, and 230.4k baud. There must be 8 data bits, no parity, and 1 stop
bit. USB Communications does not require this setting to function.
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To support the multi-drop Remote option each unit is assigned a communications
address, which is set using “Com Address” within the Systems Options of the Setup
Menu.

Communications Format
All the commands have the following format:
@123XYZ<CR>
The @ symbol initiates the command, all commands must begin with this symbol. The
number 123 is the address of the Model 9840 which should respond to this command.
This MUST be 3 digits so type 001 for unit one, and 026 for unit twenty-six. The
command itself will be a sequence of letters such as the XYZ shown above. If the
command requires a number as one of its parameters the number must be followed by
the pound sign “#”. Numbers that are less than one should include a leading zero so you
should type 0.123# to enter one hundred-twenty three thousandths. Commands are not
processed until a carriage return <CR> is sent.
No Model 9840 will respond to address 000. All Model 9840s will respond to address
255. Throughout the rest of this section we will assume that you are using address 123.
Whenever a Model 9840 executes a remote command it will issue an “acknowledge” that
includes the address and any required data.
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RS232 RUN MODE COMMAND SUMMARY

@(addr)
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╚═

H
HT
?
FV
FS
FA
F
V
P
R
X
T

(item)(unit)
(number)
(item)(unit)(repeat) …
(repeat)
(tare)(pk)(val)…(pos)
(hold)(text)

Hello fetches unit description
Hello fetches unit description
Get item and unit numbers
View item and unit settings
Set displayed item and unit
Alternate display, like view button
Switches view pointer to specified
display
Get Value of an item and unit
OPT
Print
a set of readings
Reset readings
OPT
Freeze
display
Place text on display

SERIAL RUN MODE COMMANDS
The commands listed in this section mirror (and in some cases extend) the functions that
are available from the touch screen of the Model 9840 when it is in Run Mode.
Each entry will include the name of the command, followed by a short description that
includes the command format, an example that shows what you would type (shown in
plain font) and what the Model 9840 would return (shown in italics).

Hello Command (H)
This command fetches the model, version, and serial number of any unit at the specified
address.
Example:
@123H
Acknowledge:
@ 123 Interface Model 9840 Version 8.0.1 Serial #12345 Option #
457977664

Hello Touch Screen Command (HT)
This command operates the same as the hello command, but also appends the touch
screen version number.
Example:
@123H
Acknowledge:
@ 123 Interface Model 9840 Version 8.0.1 Serial #12345 Option #
457977664 Touch Screen V1.0.3
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Question Mark Command (?)
This command returns a list of item numbers and unit numbers that are available on the
Model 9840 that is addressed. These numbers are used as arguments for the many of
the commands shown below**.
Example:
@123?
Acknowledge:
@ 123 These are the Item numbers:
00 - Load A
01 - Peak A
02 - Vall A
03 - Load B
04 - Peak B
05 - Vall B
14 - Grs A
15 - Grs B
OPT
26 - Load C
27 - Peak C
28 - Vall C
16 - Ch A+B
29 - Load D
30 - Peak D
31 - Vall D
32 - Grs C
33 - Grs D
**Alternatively torque units may be displayed or a combination of
both depending upon which cell is loaded on which channel:
17 - Torque A
18 - Peak A
19 - Vall A
20 – Gross A
21 - Torque B
22 - Peak B
23 - Vall B
24 – Gross B
25 - Ch A+B OPT
These items are for value display purposes only:
50 – Cell* AB
51 - Peak AB
52 - Vall AB
*

Note: If the channel is set as a load channel, the cell type implied is a LOAD
CELL; if the channel is configured as a torque channel, the cell type implied is a
TORQUE CELL.

These are the units for Load, Peak, and Valley:
00 - Lb
01 - kg
02 - N
03 - Psi
04 - MPa
05 - Klb
06 - kN
07 - t
08 - mvV
09 – g
These are the units for Torque:
00 – LbI
01 – NM
02 – OzI
03-mVv

Front Panel Display Command (F)
This command is used to set the front panel display of the Model 9840 to a desired
combination of item and unit. There are five subcommands: Front panel View (FV), Front
panel Set (FS), Front panel Alternate (FA), Front panel pointer control to line 1 (F1), and
Front panel pointer control to line 2 (F2).

Front Panel View Command (FV)
The Front panel View (FV) command just tells you what is currently on the display, and
what will be displayed when the View button on the front panel is pressed.
Example:
@123FV
Acknowledge:
@ 001 Active Display shows
Other Display shows
Other Display shows
Other Display shows
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Load
Load
Load
Load

A
B
C
D

in
in
in
in

kg
Lb
Lb
Lb

[1]
[2]
[3]
[4]
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Front Panel Set Command (FS)
The Front panel Set (FS) command allows you to specify the item number and unit
number for what is currently on the front panel display. The format is FS (item
number)(unit number), where the first item and unit numbers are 2 digits each and may
be found using the question mark command (?).
Example:
@123FS0200
Acknowledge:
@ 001 Active Display shows
Other Display shows
Other Display shows
Other Display shows

Vall
Load
Load
Load

A
B
C
D

in
in
in
in

Lb
Lb
Lb
Lb

[1]
[2]
[3]
[4]

Front Panel Alternate Command (FA)
The Front panel Alternate (FA) command allows you to switch between the currently
displayed item and unit and the alternate item and unit just as if you had pressed the
View button.
Example:
@123FA
Acknowledge:
@ 001 Active Display shows
Other Display shows
Other Display shows
Other Display shows

Load
Vall
Load
Load

B
A
C
D

in
in
in
in

Lb
Lb
Lb
Lb

[2]
[1]
[3]
[4]

Front Panel Pointer Control to Line n (Fn)
The Front Panel Pointer Control to Line n (Fn) assigns the view pointer control to
display line 1 to 4 and shows what is on the display. This allows the operator to know
which line will be configured or accessed. The displays are indexed left to right, top to
bottom.

Example:
@123F3
Acknowledge:
@ 001 Active Display shows
Other Display shows
Other Display shows
Other Display shows
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Load
Vall
Load
Load

C
A
B
D

in
in
in
in

Lb
Lb
Lb
Lb

[3]
[1]
[2]
[4]
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Value Command (V) for any channel
The value command for any channel is used to read the numerical value of a desired item
and unit without altering the front panel display. The format is V(item number)(unit
number)(repeat) … , where the item and unit numbers can be found using the question
mark command (see above), and the repeat number must be 0,1, or 2. Choosing repeat
1 will command the Model 9840 to send you the desired value once. Choosing repeat 2
will command the Model 9840 to send the value at approximately 0.1 second intervals.
Choosing repeat 0 will turn off any values that are being sent by a repeat 2 command.
The pattern can be repeated to view up to four desired items and units. Note: when
choosing to view Limits, use "00" for the unit part of the command.
Example:
@123V01021
Acknowledge:
@123 Peak A 55.676 N
Example 2:
@123V00002
Acknowledge 2:
@123 Load A 120.45 Lb
@123 Load A 125.29 Lb
.....
@123 Load A 137.81 Lb
The value command for both channels is similar to the command for one channel with the
following exceptions:
The item numbers available for two channel value display are 50 (Cells AB), 51 (Peak
AB), and 52 (Valley AB).
The format is V(item number)(unit number channel A) (unit number channel B)(repeat),
where the item must be 50, 51, or 52 and unit numbers can be found using the question
mark command (see above). Make sure to use the proper unit numbers for the proper
cell type. A unit number of 08 for a torque cell will result in an unusable argument
message.
The repeat number is exactly like the one channel command. It must be 0, 1, or 2.
Choosing repeat 1 will command the Model 9840 to send you the desired value once.
Choosing repeat 2 will command the Model 9840 to send the value at approximately 3
second intervals. Choosing repeat 0 will turn off any values that are being sent by a
repeat 2 command.
Example 3:
@123V5000002
Acknowledge 3:
@ 123 Load A 120.45 Lb Torq B 120.45 LbI
@ 123 Load A 125.29 Lb Torq B 137.81 LbI
.....
@ 123 Load A 128.29 Lb Torq B 146.81 LbI
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The format can also be repeated to view multiple items at once, up to four items. The
format is V(item 1)(unit 1)(repeat 1)(item 2)(unit 2)(repeat 2)(item 3)(unit 3)(repeat 3)
(item 4)(unit 4)(repeat 4), where item and unit can be any from the question mark
command. This format can also work with the two channel format from Example 3.
Example 4:
@123V500000226002
Acknowledge 4:
@ 123 Load A 120.45 Lb
@ 123 Load A 125.29 Lb
.....
@ 123 Load A 128.29 Lb

Torq B 120.45 LbI
Torq B 137.81 LbI

Load C 2.9993 Lb
Load C 2.9992 Lb

Torq B 146.81 LbI

Load C 2.9997 Lb

OPTION ~ Print Command (P)
If the print option is purchased, the print command will fetch a full set of readings (like
pressing the front panel Esc button). These will be in the units that are currently selected
on the numerical display. The format is P(repeat number), where the repeat number
must be 0, 1, 2, or 3. Repeat 1 will return 1 set of readings to the RS232 terminal.
Repeat 2 will return a set of readings approximately every three seconds (like the value
command). Repeat 0 will turn off printing that was started with repeat 2. Repeat 3 will
send one set of readings to the serial printer attached to the Model 9840 instead of to the
RS232 terminal.
Example:
@123P1
Acknowledge:
@ 001 Load A
Peak A
Vall A
Load B
Peak B
Vall B
Grs A
Grs B
Ch A+B
Load C
Peak C
Vall C
Load D
Peak D
Vall D
Grs C
Grs D
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0.01870
0.50350
-0.48390
4.44386
4.56994
0.00000
0.01680
-4.37317
4.46470
7.24133
7.91961
-1.80038
-8.83013
1.96601
-8.83320
8.04560
-9.81467

Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
Lb
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Reset Tare, Peak, Valley or Position OPT Command (R)
This command allows you to reset the tare, peak, valley, or position readings. The format
is R(tare A)(peak A)(valley A)(tare B)(peak B)(valley B)(position select), where the selects
are either a 0 (don’t reset) or a 1 (reset). Thus you can reset any combination of these
readings with a single command.
Example:
@123R111111111111
Acknowledge:
@ 123 Reset - Tare A Peak A Valley A Tare B Peak B
Tare C Peak C Valley C Tare D Peak D Valley D
Example 2:
@123R100100100000
Acknowledge 2:
@ 123 Reset - Tare A Tare B Tare C

Valley B

OPTION ~ Display Hold / Freeze Display Command (X)
In Run Mode, the freeze display command will freeze and unfreeze the run mode
numerical display and the values sent from the unit for RS232 output using either the
remote Value or Print command. Send the command once to freeze the display and
output at the current value. Send again to return display and output to actual reading
from sensor
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RS232 SETUP MODE COMMAND SUMMARY
@(addr)
╠═
║
║
║
║
╠═
║
║
║
╠═
║
║
║
║
║
║
╠═
║
║
║
║
║
║
║
║
║
║
║
║
╠═
║
║
║
║
║
╠═
║
║
║
║
║
║
║
║
║
║
║
║
║
╚═

U
╠═
╠═
╚═

V
A
L

A
╠═
╚═

V
S

S
╠═
╠═
╠═
╠═
╚═

(ch)
V
S
D
T

C
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╚═

C
B
E
V
MV6
M
T
S
I
╠═
╚═

(item)(unit)(full)#(zero)#

Analog Output
View current settings
Set analog output

(channel)(serial number)#
(serial number)#
(channel)

Sensor Select
View current sensor on ch
View current sensors
Select sensor by S/N
Delete sensor by S/N
OPT
View TEDS
T33 data

(see text for format)
(mv/v constant)#
(see text for format)
(see text for format)
(see text for format)
(shunt value Lb)#
V
S(number)#

Calibration
Shunt Check load cell
Begin load cell calibration
Escape load cell calibration
Calibrate by mV/V - 1 pt.
Calibrate by mV/V - 6 pt.
Calibrate by Mass 2&5 pt.
Calibrate by Torque 2&5 pt.
Calibration by Shunt Value
OPT
Encoder
counts per Inch
View counts/inch
Set counts/inch
OPT

L(lim)
╠═
╠═
╠═
╚═

V
S
E
R

O
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╠═
╚═

V
I
N
Z
A
B
L
T
E
D
U
S

D
╠═
╠═
╠═
╠═
╠═
╚═

V
F
W
D
P
C
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(channel)(number) #
(number) #

User Data Entry
View current settings
Set Base Area
OPT
Set Base Length

(see text for format)

Limits
View current settings
Setup limit
Escape from limit setup
Manual reset for latch

(0 or 1)
(0 or 1)
(channel)(0 or 1)
(new address)#
(baud rate code)
(0 or 1)
(0 or 1)
(0 or 1)
(0 or 1)
(0 or 1)
(0 or 1)

System Options
View current settings
Auto-Identify load cells
Autoid Annunciator
Auto-Zero load
Com Address
Com Baud Rate
Com Linefeed
Retain Tare
End of Transmission Char.
OPT
TEDS
Enable
Auto Tare
Serial command Source

(type)(level)
(see text for format)
(channel)(number digits)
(number digits)
(channel)(countby code)

Display Options
View current settings
Filter select
Filter Window
Decimal digits max
OPT
Position
digits max
Smallest count
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RS232 SETUP MODE COMMANDS
The commands in this section allow you to change the setup of the Model 9840. You will
notice that these commands form a menu which approximately duplicates the Setup
Mode menu used during setup of the Model 9840 from the front panel. There are
additional commands that are for Serial use only.
If the optional Keylock is installed and locked you will not be to alter the setup until the
unit has been unlocked. The acknowledgement will indicate this fact:
@ 123 Setup is Locked - use Keylock to unlock.

User Data Entry Command (U)
This command is used to view or set the options in the user data entry menu, namely the
base area (used to calculate load in PSI, or MPa) and base length (used to calculate
position in %). This command has three subcommands: User data View (UV), User data
Area (UA), and User data Length OPT (UL).

User Data View Command (UV)
The User data View (UV) command has the format UV.
Example:
@123UV
Acknowledge:
@ 123 Base Area Ch A is 1.00000 sq-in
Base Area Ch B is 0.50000 sq-in
Base Length is 3.0000 in

User Data Area Command (UA)
The User data Area (UA) command is used to set the base area. The format is
UA(channel)(number)#.
Example:
@123UAA1.0025#
Acknowledge:
@ 123 Base Area Ch A is 1.0025 sq-in

User Data Length OPT Command (UL)
The User data Length (UL) command is used to set the base length. The format is
UL(number)#
Example:
@123UL2.5#
Acknowledge:
@ 123 Base Length is 2.5000 in
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Analog Output Command (A)
This command is used to view or set the analog output of the Model 9840. There are two
subcommands Analog View (AV) and Analog Set (AS).

Analog Output View Command (AV)
The Analog View (AV) command has the format AV. It will return the current settings
of the analog output.
Example:
@123AV
Acknowledge:
@123 Analog Output A is Load A in Lb
10.0 Volts indicates 1000 Lb
0.0

Volts indicates 0.00 Lb

Analog Output Set Command (AS)
The Analog Set (AS) command is used to change the settings of the analog output.
The format is AS(item number)(unit number)(full scale)#(zero scale)#, where the item
and unit numbers are used to determine the signal source for the analog output, the
full scale number indicates what signal level is assigned to full scale analog output of
10.0 volts, and the zero scale number indicates the signal level assigned to zero volts
analog output. Note that when you change a cell type (from load to torque or back
again) these settings must be reset for the new cell.
Example:
@123AS090010.0#5.0#
Acknowledge:
@ 123 Analog Output is Pos OPT in In
10.0 Volts indicates 10.00 In
0.0 Volts indicates 5.00 In

Sensor Command (S)
This command is used to view or select calibration data from the list of calibrated load
cells maintained by the Model 9840. There are 3 subcommands, Sensor View (SV),
Sensor Select (SS), and Sensor Delete (SD).

Sensor View Channel A or B Command (SA or SB)
The Sensor View Channel A or B (SA or SB) command has the format SA or SB. It
returns information about the cell currently loaded on channel A (SA) or channel B(SB)
including the serial number, the maximum load rating, the milli-volt per Volt calibration
constant, the excitation voltage used, the latest date of calibration, and the shunt value
recorded during that calibration. No other cells are listed.
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Example:
@123SA
Acknowledge:
@ 123 This is the list of cell calibration data:
Ch A = S/N 123456, 100.00 Lb
, 3.00150 mV/v,
10.00 V
, Cal on Oct27-99, 49.532 Lb Shunt

Sensor View Command (SV)
The Sensor View (SV) command has the format SV. It returns information about the
currently selected cell including the serial number, the maximum load rating, the millivolt per Volt calibration constant, the excitation voltage used, the latest date of
calibration, and the shunt value recorded during that calibration. All other cells
currently in the unit are listed as well.
Example:
@123SV
Acknowledge:
@123 This is the list of cell calibration data:
Ch A = S/N 123456, 100.00 Lb
, 3.00150 mV/v,
10.00 V
, Cal on Oct27-99, 49.532 Lb Shunt
unused S/N 13368, 10.00 Lb
, 3.00121 mV/v,
10.00 V,
Cal on Oct27-99, 4.9292 Lb Shunt
Ch C = Ch D = S/N 63220, 100.00 Lb
, 2.99984 mV/v,
10.00 V
, Cal on Oct27-99, 49.381 Lb Shunt
Ch B = S/N 89991, 1000.0 Lb
, 4.50015 mV/v,
5.00 V
, Cal on Oct27-99, 486.45 Lb Shunt

Sensor Select Command (SS)
The Sensor Select (SS) command is used to select the calibration data for a stored
cell using the cell serial number. The format is SS(channel)(serial number)#.
Example:
@123SSA13368#
Acknowledge:
@123 This is the list of load cell calibration data:
unused S/N 123456, 100.00 Lb
, 3.00150 mV/v,
10.00 V
, Cal on Oct27-99,
49.532 Lb
Ch A = S/N 13368, 10.00 Lb
, 3.00121 mV/v,
10.00 V
, Cal on Oct27-99,
4.9292 Lb
Ch C = Ch D = S/N 63220, 100.00 Lb
, 2.99984
10.00 V
, Cal on Oct27-99,
49.381 Lb
Ch B = S/N 89991, 1000.0 Lb
, 4.50015 mV/v,
5.00 V
, Cal on Oct27-99,
486.45 Lb
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Sensor Delete Command (SD)
The Sensor Delete (SD) command is used to remove the calibration data for a stored
cell from the list. The format is SD(serial number)#.
Example:
@123SD13368#
Acknowledge:
@ 123 Deleted Sensor S/N 13368
Ch A = S/N 123456, 100.00 Lb , 3.00150 mV/v,
10.00 V
, Cal on Oct27-99, 49.532 Lb Shunt
Ch C = Ch D = S/N 63220, 100.00 Lb , 2.99984 mV/v,
10.00 V
, Cal on Oct27-99, 49.381 Lb Shunt
Ch B = S/N 89991, 1000.0 Lb , 4.50015 mV/v,
5.00 V
, Cal on Oct27-99, 486.45 Lb Shunt

Sensor View TEDS OPT T33 Command (ST)
The Sensor View TEDS (ST) T33 command is used to view an attached TEDS
Template 33 sensor.
Example:
@123STB
Acknowledge:
@ 123
Channel B TEDS
1) Mfg ID: 59
2) Model Number: 0
3) Version Letter:
4) Version Number: 1
5) Serial Number: 31448
6) Physical Measurand Case: 5 (Lb)
7) Minimum Physical Value: 0
8) Maximum Physical Value: 15
9) Full Scale Electric Value Precision: 2 (32 Bits)
10) Minimum Electrical Output: 0 mV/V
11) Maximum Electrical Output: 3.10684 mV/V
12) Bridge Type: 2 (Full)
13) Bridge Impedance: 350.0 Ohms
14) Bridge Response Time: .001 mSecs
15) Excite Level Nominal: 10.0 Volts
16) Excite Level Minimal: 5.0 Volts
17) Excite Level Maximum: 15 Volts
18) Calibration Date: 04/06/06
19) Calibration Initials: KM
20) Calibration Period: 365
21) Measurement Location ID: 1
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Calibration Command (C)
This command has 8 subcommands. Calibration Check (CC) is used to run a shunt
calibration check on a cell. Calibration Begin (CB) starts the calibration of a new or
existing cell. Calibration by milli-volt per Volt may be done using one point (CV) which
runs a calibration using the cell milli-volt per Volt constant or 6 point which uses cell
manufacturer supplied mass and milli-volt per Volt data (CMV6). Calibration by Masses
(CM) does a two or five point mass calibration. Calibration by Torque (CT) does a two or
five point torque calibration. Calibration by Shunt (CS) does calibration based on the
shunt value of the cell. Calibration Escape (CE) cancels a calibration that is underway.
Calibration counts per Inch View (CIV) displays the current setting of the encoder counts
per inch constant, and Calibration counts per Inch Set (CIS) lets you set the encoder
counts per inch constant.
Cells must be calibrated for the channel on which they will be used.
Note: All calibrations can be performed using positive or negative values! For multipoint
calibrations this will allow for nonlinear calibrations across zero.

Calibration Check Command (CC)
The Calibration Check (CC) command runs a calibration check on the currently
selected cell. Note that the load cell should not be under load or torque when this
check is run. During the 10 second shunt calibration the front panel will show “RS232
Cal Check”. After the 10 seconds the unit will return to run mode and send the
acknowledge line shown below. This indicates both the current reading of the shunted
cell and the reading that was recorded when this cell was last calibrated.
Example:
@123CCA
Acknowledge:
@123 Cal Check Ch A, S/N 123456
Shunt Value is 49.532 Lb
Cal Value was 49.531 Lb

Calibration Begin Command (CB)
The Calibration Begin (CB) command is a 4 part command used to start a calibration
by any method. You must issue a CB command before trying calibration by milli-volt
per Volt, masses, or shunt (CV, CM, CT or CS). While the Model 9840 is being
calibrated using the remote commands, the front panel will show “RS232 CAL
STARTED”. Pressing the front panel Esc button will cancel the calibration and issue a
warning to the RS232 terminal. If any remote commands other than calibration
commands are issued, the calibration will also be canceled. The acknowledgement
will indicate if this is a “New Cell” or if you are going to “Overwrite” existing data. If you
do not wish to overwrite use the CE command to stop this calibration. Another method
of overwriting existing data is to delete the sensor first and then calibrate. The CB1
Command has been modified to accept the cell type but is still usable by older
software.

MO D E L 9 8 4 0

PG 37

PUB. 6032-01

I N T E R F AC E M O D E L 9 8 4 0

The format for the CB commands is:
For backward compatibility:
CB1(space)(channel)(serial number)#
Alternatively, to delineate between a Load and a Torque Cell:
CB1(cell type)(channel)(serial number)#
CB2(space)(month)(day)(year)
CB3(space) (excitation)(calibration unit)
CB4(space)(rated load)#
where cell type is 0 for load and 1 for torque, channel is A or B, serial number is the
serial number of the cell, not exceeding 8 characters, month, day, and year are 2 digit
numbers to represent the current date, excitation should be a 0 for 5.00 volts or a 1 for
10.00 volts, and calibration unit is the desired unit for this calibration, and rated load is
the maximum load or torque rating for the cell.
Example 1:
@123CB1 A123456#
Acknowledge 1:
@ 123 Calibrate Begin 1 Command – New
Load Cell S/N: 123456 – Channel A
Example 1A:
@123CB11A123456#
Acknowledge 1:
@ 123 Calibrate Begin 1 Command – New
Torque Cell S/N: 123456 – Channel A
Example 2:
@123CB2 042298
Acknowledge 2:
@ 123 Calibrate Begin 2 Command –
Cal Date: Apr22-98
Example 3:
@123CB3 100
Acknowledge 3:
@ 123 Calibrate Begin 3 Command –
Excitation Voltage: 10.0 V,
Example 4:
@123CB4 1000.0#
Acknowledge 4:
@ 123 Calibrate Begin 4 Command –
Rated Load: 1000.0 Lb
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Calibration Escape Command (CE)
The Calibrate Escape (CE) command is used to cancel a calibration that was started
with the Calibrate Begin (CB) command. This format is CE.
Example:
@123CE
Acknowledge:
@ 123 Calibrate Command - Canceled, Calibration NOT Changed

Calibrate by Milli-volt per Volt Command for One Point (CV)
The Calibrate by milli-volt per Volt (CV) command is used to calibrate a load cell using
its milli-volt per Volt calibration constant. You must have already started a calibration
using the CB command for this command to function. The format is CV(milli-volt per
Volt constant)# Note that a shunt check calibration will also be run at this time and so
it is important that the load cell is not under load when this command is entered. Note
that this command works for torque cell calibration as well.
Example:
@123CV4.5002#
Acknowledge:
@ 123 Calibrate Command - Reading for Shunt Check...
[10 seconds delay]
@ 123 Calibrate Command Completed
Ch A = S/N 123456, 1000.0 Lb
, 4.50020 mV/v,
10.00 V
, Cal on Oct27-99, 553.26 Lb Shunt
unused S/N 63220, 100.00 Lb
, 2.99984 mV/v,
10.00 V
, Cal on Oct27-99, 49.381 Lb Shunt
Ch B = S/N 89991, 1000.0 Lb
, 4.50015 mV/v,
5.00 V
, Cal on Oct27-99, 486.45 Lb Shunt

Calibrate by Milli-volt per Volt Command for Six Points (CMV6)
The Calibrate by milli-volt per Volt for six points (CMV6) command is used to calibrate
a load cell using 6 points of mass and milli-volt per Volt each. You must have already
started a calibration using the CB command for this command to function. The format
is CMV6. Note that a shunt check calibration will also be run at the end of the
calibration and so it is important that the load cell is set at 0 (or no masses) when the
final command is entered.
Example:
@123CMV6
Acknowledge:
@ 123 Calibrate by milli-volt per Volt - 6 Point
Ready for Mass CMVM1 command
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Calibrate by mV/V Mass and Volt Commands (CMVM and CMVV)
The Calibration by mV/V Mass (CMVM) and Volt (CMVV) commands can have up to
seven parts each: CMVM1 through CMVM6 and CMVM0; and CMVV1 through CMVV6
and CMVV0. You must have already started a calibration using the CB and CMV6
commands for any of these commands to function. To input the first mass issue the
Calibration by mV/V Mass 1 (CMVM1) command. The mass is entered using the
following format: CMVM1(mass value)#. Entering this command will result in the unit
prompting the user for the first milli-volt per Volt command.
Example:
@123CMVM15.0005#
Acknowledge:
@ 123 Calibrate Mass 1 Command entered
Ready for mV/V Value CMVV1 or CE command
The CE or Calibration Escape command will, if entered, end this calibration without
calibrating the unit. The unit will remain calibrated according to the most recent
calibration or, if this is the first calibration of the unit, the unit will remain un-calibrated.
At this point the unit is prompting the user for the first milli-volt per Volt value of the
calibration. The mV/V value is entered using the Calibration by mV/V Volt Command
with the following format: CMVV1(mV/V value)#.
Example:
@123CMVV11.9926#
Acknowledge:
@ 123 Calibrate mV/V 1 Command entered
Ready for Mass Value CMVM2 or CE command
The unit will continue to prompt the user for mass and milli-volt per Volt values until the
six points have been entered. Then the user will see the following acknowledgement:
@ 123 Calibrate mV/V 6 Command entered
Ready for Mass Value CMVM0 or CE command
The user must now enter the CMVM0 command to finish the calibration. Note the load
cell should have no masses on it at this point since a shunt calibration is run.
Example:
@123CMVM0
Acknowledge:
@ 123 Calibrate Command - Reading for Shunt Check…
[10 seconds delay]
@ 123 Calibrate Command Completed
Ch A = S/N 123456, 1000.0 Lb
, 4.50020 mV/v,
4.50020 mV/v,
4.50020 mV/V,
4.50020 mV/V,
4.50020 mV/V
5.00 V
, Cal on Oct27-99,
553.26 Lb Shunt
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Calibrate by mV/V Torque and Volt Commands (CMVT and CMVV)
The Calibration by mV/V Torque (CMVT) and Volt (CMVV) works exactly like the
Calibrate by mV/V Mass and Volt commands. These commands can have up to seven
parts each: CMVT1 through CMVT6 and CMVT0; and CMVV1 through CMVV6 and
CMVV0. You must have already started a calibration using the CB and CMV6
commands for any of these commands to function. To input the first torque issue the
Calibration by mV/V Torque 1 (CMVT1) command. The torque is entered using the
following format: CMVT1(torque value)#. Entering this command will result in the unit
prompting the user for the first milli-volt per Volt command.
Example:
@123CMVT15.0005#
Acknowledge:
@ 123 Calibrate Torque 1 Command entered
Ready for mV/V Value CMVV1 or CE command
The CE or Calibration Escape command will, if entered, end this calibration without
calibrating the unit. The unit will remain calibrated according to the most recent
calibration or, if this is the first calibration of the unit, the unit will remain un-calibrated.
At this point the unit is prompting the user for the first milli-volt per Volt value of the
calibration. The mV/V value is entered using the Calibration by mV/V Volt Command
with the following format: CMVV1(mV/V value)#.
Example:
@123CMVV11.9926#
Acknowledge:
@ 123 Calibrate mV/V 1 Command entered
Ready for Torque Value CMVT2 or CE command
The unit will continue to prompt the user for mass and milli-volt per Volt values until the
six points have been entered. Then the user will see the following acknowledgement:
@ 123 Calibrate mV/V 6 Command entered
Ready for Torque Value CMVT0 or CE command
The user must now enter the CMVT0 command to finish the calibration. Note the
torque cell should have no torque on it at this point since a shunt calibration is run.
Example:
@123CMVT0
Acknowledge:
@123 Calibrate Command - Reading for Shunt Check…
[10 seconds delay]
@ 123 Calibrate Command Completed
Ch A = S/N 123456, 1000.0 LbI
, 4.50020 mV/v,
4.50020 mV/v,
4.50020 mV/V,
4.50020 mV/V,
4.50020 mV/V
5.00 V
, Cal on Oct27-99,
553.26 LbI Shunt
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Calibrate by Masses Command (CM)
The Calibrate by Masses (CM) command tells the unit that you are doing a calibration
by 2 point mass or by 5 point mass. The format is CM(number of masses).
Example:
@123CM5
Acknowledge:
@ 123 Calibrate by Mass – 5 Point
Ready for CMP1 command

Calibrate by Masses Point Command (CMP)
The Calibration by Masses Point (CMP) command can have up to six parts: CMP1
through CMP5 and CMP0. You must have already started a calibration using the CB
and CM commands for any of these commands to function. To read the first mass
issue the Calibration Mass Point 1 (CMP1) command. The format is CMP1(mass)#.
This will cause the Model 9840 to read 10 seconds of data from the load cell. These
readings are averaged to obtain the first calibration mass reading. The example uses
0.0 Lb for the first mass. Be sure you have placed the mass on the load cell before
entering this command since reading will begin immediately.
Example:
@123CMP10.0#
Acknowledge:
@ 123 Calibrate Mass 1 Command - Reading...
[10 seconds delay]
Calibrate Mass 1 Command - Ready for CMP2 or CE command
The Calibrate Mass 2 (CMP2) command has the format CMP2(mass)#. This
command can only be issued after the CMP1 command has completed. The example
uses 500 Lb for the second calibration mass. Be sure you have placed the mass on
the load cell before entering this command since reading will begin immediately
Example:
@123CMP2500#
Acknowledge:
@ 123 Calibrate Mass 2 Command - Reading...
[10 seconds delay]
Calibrate Mass 2 Command - Ready for CMP3 or CE command
Masses three through five are done in a similar manner. The Calibrate Mass Point 0
(CMP0) command completes the 2 or 5 point mass calibration. Remove the masses
from the load cell before entering this command since it will perform the shunt
calibration measurement that is recorded for use with the calibration check command.
The format is CMP0.
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Example:
@123CMP0
Acknowledge:
@ 123 Calibrate Command - Reading for Shunt Check...
[10 seconds delay]
@ 123 Calibrate Command Completed
Ch A = S/N 123456, 100.00 Lb
, 3.00150 mV/v,
3.00230 mV/v,
3.00238 mV/v,
3.00353 mV/v,
10.00 V
, Cal on Oct27-99, 49.532 Lb Shunt
Ch C = S/N 13368, 10.00 Lb
, 3.00121 mV/v,
10.00 V,
Cal on Oct27-99, 4.9292 Lb Shunt
Ch D = S/N 63220, 100.00 Lb
, 2.99984 mV/v,
10.00 V
, Cal on Oct27-99, 49.381 Lb Shunt
Ch B = S/N 89991, 1000.0 Lb
, 4.50015 mV/v,
5.00 V
, Cal on Oct27-99, 486.45 Lb Shunt

Calibrate by Torque Command (CT)
The Calibrate by Torque (CT) command tells the unit that you are doing a calibration
by 2 or 5 point torque. The format is CT(number of torques).
Example:
@123CT5
Acknowledge:
@ 123 Calibrate by Torque – 5 Point
Ready for CTP1 command

Calibrate by Torque Point Command (CTP)
The Calibration by Torque Point (CTP) command can have up to six parts: CTP1
through CTP5 and CTP0. You must have already started a calibration using the CB
and CT commands for any of these commands to function. To read the first torque,
issue the Calibration Torque Point 1 (CTP1) command. The format is CTP1(torque)#.
This will cause the Model 9840 to read 10 seconds of data from the torque cell. These
readings are averaged to obtain the first calibration torque reading. The example uses
0.0 LbI for the first mass. Be sure you have placed the torque on the cell before
entering this command since reading will begin immediately.
Example:
@123CTP10.0#
Acknowledge:
@ 123 Calibrate Torque 1 Command - Reading...
[10 seconds delay]
Calibrate Torque 1 Command - Ready for CTP2 or CE command
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The Calibrate Torque 2 (CTP2) command has the format CTP2(torque)#. This
command can only be issued after the CTP1 command has completed. The example
uses 500 LbI for the second calibration torque. Be sure you have placed the torque on
the cell before entering this command since reading will begin immediately.
Example:
@123CTP2500#
Acknowledge:
@ 123 Calibrate Torque 2 Command - Reading...
[10 seconds delay]
Calibrate Torque 2 Command - Ready for CTP3 or CE command
Torques three through five are done in a similar manner. The Calibrate Torque Point 0
(CTP0) command completes the 2 or 5 point torque calibration. Remove the torque
from the cell before entering this command since it will perform the shunt calibration
measurement that is recorded for use with the calibration check command. The
format is CTP0.
Example:
@123CTP0
Acknowledge:
@123 Calibrate Command - Reading for Shunt Check...
[10 second delay]
@123 Calibrate Command Completed
Ch A = S/N 123456, 100.00 LbI
, 3.00150 mV/v,
3.00230 mV/v,
3.00238 mV/v,
3.00353 mV/v,
10.00 V
, Cal on Oct27-99, 49.532 LbI Shunt
Ch C = S/N 13368, 10.00 Lb
, 3.00121 mV/v,
10.00 V,
Cal on Oct27-99, 4.9292 Lb Shunt
Ch D = S/N 63220, 100.00 Lb
, 2.99984 mV/v,
10.00 V
, Cal on Oct27-99, 49.381 Lb Shunt
Ch B = S/N 89991, 1000.0 Lb
, 4.50015 mV/v,
5.00 V
, Cal on Oct27-99, 486.45 Lb Shunt

Calibrate by Shunt Command (CS)
The Calibrate by Shunt (CS) command is used to calibrate the cell using the shunt
calibration factor expressed in pounds (or pound-inches for a torque cell). This
command will only function if you have already issued a Calibrate Begin (CB)
command. Note that the cell should not have any load or torque on it for this
command to operate correctly. The format is CS(shunt value in Lb or LbI)#. The
example shows calibration of a load cell using a shunt value of 553.26 Lb.
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Example:
@123CS553.26#
Acknowledge:
@123 Calibrate Shunt Command - Reading...
[10 seconds delay]
@123 Calibrate Command - Reading for Shunt Check...
[10 seconds delay]
@123 Calibrate Command Completed
Ch C = Ch A = S/N 123456, 1000.0 Lb
, 4.50014 mV/v,
10.00 V
, Cal on Oct27-99, 553.26 Lb Shunt
Ch D = S/N 63220, 100.00 Lb
, 2.99984 mV/v,
10.00 V
, Cal on Oct27-99, 49.381 Lb Shunt
Ch B = S/N 89991, 1000.0 Lb
, 4.50015 mV/v,
5.00 V
, Cal on Oct27-99, 486.45 Lb Shunt

Calibrate Counts-Per-Inch OPT Command (CI)
This command has two subcommands, a view command (CIV) and a set command
(CIS).
The Calibration counts per Inch View (CIV) command displays the current setting of
the encoder counts per inch constant.
Example:
@123CIV
Acknowledge:
@123 Encoder is 32000 counts per inch
The Calibration counts per Inch Set (CIS) command allows you to change the current
setting of the encoder counts per inch constant.
Example:
@123CIS64000#
Acknowledge:
@ 123 Encoder is 64000 counts per inch

OPTION ~ Limits Command (L)
This command allows you to view or set the 4 contact closure limit switches on the Model
9840. There are three subcommands Limit View (LiV), Limit Set (LiS), and Limit Reset
(LiR). Note that changing a cell type on a channel will automatically erase limits that were
set for that channel. They must then be reset by the user.

Limit View Command (LiV)
The Limit View (LiV) command is used to view the current settings of one of the limits.
The format is L(limit number)V.
Example:
@123L1V
Acknowledge:
@ 123 Lim 1 NO
Reset 1.000
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This line indicates that Limit 1 is a normally open switch (NO) rather than a normally
closed switch (NC). The limit is Enabled rather than Disabled. The signal driving this
limit is Load in Lb. The limit will be turned on when the load exceeds 20.00 Lb. It is
not a Latching limit (latching requires a manual reset). The limit will automatically reset
when the load is less than 1.00 Lb. Torque can be substituted for load for an
appropriate cell.

Limit Set Command (LiS)
The Limit Set (LiS) command is broken up into 4 separate commands. They have the
following format:
L(limit number)SA(space) (normal position)(enable)(item number)(unit number)
L(limit number)SB(space) (setpoint number)#
L(limit number)SC(space) (< or >)(latching)
L(limit number)SD(space) (reset point number)#
The limit number chooses which limit (1-4) you want to setup. The normal position
should be set to 0 for normally open or 1 for normally closed. The enable should be
set to 0 for disabled or 1 for enabled. If the limit is disabled the rest of this command
may be omitted (see example 3). The item and unit numbers indicate which signal is
to drive this limit. The set point number indicates the signal level at which the limit is to
be activated. The < or > sign indicates whether you want the limit to be activated when
the signal is greater than the set point (>) or less than the set point (<). The latching
should be set to 0 for latching off or 1 for latching on. If latching on is selected the rest
of the command may be omitted (see example 2). Latching on will require a manual
reset once the limit has been activated. The reset point indicates the signal level at
which the limit should be de-activated.
If you want to enable a limit without otherwise changing its settings you can enter
L(limit number)SA(space)(normal position)1# instead of entering the full setup string
(see example 4).
Example 1:
@123L1SA 010000
Acknowledge 1:
@ 123 Limit Setup Command A – Ready for Command B
Example 2:
@123L1SB 50.0#
Acknowledge 1:
@ 123 Limit Setup Command B – Ready for Command C
Example 3:
@123L1SC >0
Acknowledge 3:
@ 123 Limit Setup Command C – Ready for Command D
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Example 4:
@123L1SD 10.0#
Acknowledge 4:
@ 123 Lim 1 NO
Reset 10.00

Enabled Load A Lb Set

Example 5:
@123L1SA 10
Acknowledge 5:
@ 123 Lim 1 NO Disabled Load A Lb Set
Off Reset 10.00
Example 6:
@123L1SA 11#
Acknowledge 6:
@ 123 Lim 1 NC
Reset 10.00

Enabled Load A Lb Set

50.00 Trip>Set Latch Off

50.00 Trip>Set Latch

50.00 Trip>Set Latch Off

Limit Setup Escape (LE)
The Limit Escape (LE) command is used to cancel a limit setup that was started with
the Limit Set (LiS) command. This format is LE.
Example:
@123LE
Acknowledge:
@ 123 Limit Setup Command Canceled

Limit Reset Command (LiR)
The Limit Reset (LiR) command is used to manually reset a latching limit that has been
activated. The format is L(limit number)R.
Example:
@123L1R
Acknowledge:
@ 123 Reset Limit 1

System Options Command (O)
The system Options command has 8 subcommands that are used to view or set the
options that appear on the system options menu. Option View (OV) displays all the
settings in the system options menu, Option Printer (OP) is used to set the printer baud
rate, Option Auto ID (OI) is used to turn auto-identification of load cells on or off, Option
Auto Zero (OZ) is used to turn auto-zeroing of load on or off, Option Com Address (OA) is
used to change the communications address of the unit, Option Baud Rate (OB) is used
to change the communications baud rate, Option Linefeed (OL) is used to turn the auto
line feed option on or off, and OE which is used to turn the end of transmission character
on or off. Each of these options is described below.
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Option View Command (OV)
The Option View (OV) command returns a list of the current settings of all the system
options. The format is OV.
Example:
@123OV
Acknowledge:
@ 001 Auto Identify is on
Auto Identify Annunciator is on
TEDS is on
Auto Tare is on
Auto Zero Channel A is off
Auto Zero Channel B is off
Auto Zero Channel C is off
Auto Zero Channel D is on
Com Address is 001
Com Baud Rate is
9600
Com Line Feed is on
Retain Tare is off
Freeze Display is off
RS232 End of Transmission Character is off

Option Printer OPT Baud Rate Command (OP)
The Option Printer Baud Rate (OP) command is used to select the printer baud rate.
The format is OP(code) where the code is from the table shown at the right.
Example:
@123OP9
Acknowledge:
@ 123 Printer Baud Rate is

Option Printer
Command
230.4K

Option Auto-Identify Command (OI)
The Option auto-Identify (OI) command is used to turn
auto-identification of load cells on or off. The format is
OI(0 or 1), where 0 turns auto-id off, and 1 turns autoid on.

Code

Baud Rate

4

4800

5

9600

6

19.2K

8

57.6K

9

230.4K

Example:
@123OI0
Acknowledge:
@ 123 Auto Identify is off
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Option Auto-Identify Annunciator (ON)
The Option Auto-Identify (ON) Annunciator command is used to turn the Auto-ID
annunciator “t” on or off. The format is ON(0 or 1) where 0 & 1 turn the annunciator
off and on, respectively. When on and an AutoID is on and a recognized AutoID cell is
attached a solid “t” will show up on the first character for that channels item. The “t”
will blink if a non-recognized or non AutoID is attached.
Note: The TEDS “T” annunciator will override the auto-ID annunciator if TEDS is
enabled.
Example:
@123ON1
Acknowledge:
@ 123 Auto Identify Annunciator is On

Option TEDS OPT Enable Command (OD)
The Option TEDS Enable (OD) command is used to turn TEDS on or off. The format
is OD(0 or 1), where 0 turns TEDS off, and 1 turns TEDS on.
Example:
@123OD1
Acknowledge:
@ 123 TEDS Feature is Enabled

Option Auto-Tare (OU)
The Option Auto-Tare (OD) command is used to turn Auto-Tare on or off. The format
is OU(0 or 1), where 0 turns auto-tare off, and 1 turns auto-Tare on. Auto Tare when
on will automatically perform a Tare when a recognized Auto-ID or TEDS sensor is
attached.
Example:
@123OU1
Acknowledge:
@ 123 Auto Tare is On

Option Auto-Zeroing Command (OZ)
The Option auto-Zero (OZ) command is used to turn auto-zeroing of load on or off.
The format is OZ(channel)(0 or 1) where channel is A or B and 0 & 1 turn auto-zeroing
off and on, respectively.
Example:
@123OZA1
Acknowledge:
@ 001 Auto Zero
Auto Zero
Auto Zero
Auto Zero

MO D E L 9 8 4 0

Channel
Channel
Channel
Channel

A
B
C
D

is
is
is
is

on
off
off
on

PG 49

PUB. 6032-01

I N T E R F AC E M O D E L 9 8 4 0

Option Com Address Command (OA)
The Option com Address (OA) command is used to change the communications
address assigned to this unit. The format is OA(new address)#. Note that valid
addresses are 1 through 254.
Example:
@123OA003#
Acknowledge:
@ 123 Com Address is 003

Option Com Baud Rate Command (OB)
The Option Com Baud Rate (OB) command is used to
change the communications baud rate for this unit.
The format is OB(code), where the baud rate codes
are given in the table. Note that the acknowledgement
is given at the current baud rate and then the baud
rate is changed.

Option Baud Rate
Command
Code

Baud Rate

0

300

1

600

2

1200

Example:
@123OB2#
Acknowledge:
@ 123 Changing Communications Baudrate
to
1200

3

2400

4

4800

5

9600

6

19.2K

Option Linefeed Command (OL)

7

38.4K

8
57.6K
The Option com Linefeed (OL) command turns on or
off the generation of linefeed characters when the
9
230.4K
Model 9840 sends information to your RS232 terminal.
The format is OL(0 or 1), where 0 turns linefeeds off, and 1 turns them on.
Example:
@123OL1
Acknowledge:
@123 Com Linefeed is on

Option Tare Retain Command (OT)
The Retain Tare (OT) command enables and disables the retention of the current tare
value in memory for use after the unit has been powered down and then powered back
up. The format for the OT command is: OT(0 or 1), where 0 is disable and 1 is enable.
Once enabled, the tare values are retained until this option is disabled. Disabling the
tare retention option resets the tare values for both channels to 0.
Example:
@123OT1
Acknowledge:
@ 123 Retain Tare is on
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Option End of Transmission Character (OE)
The end of transmission character is a non-visible character (hexadecimal 0x04) that is
sent at the end of each response by the unit to an RS232 command. The character is
sent after the last carriage-return line-feed returned by the unit with one exception:
when the user is viewing channel values with the @123V(item)(unit)(repeat) and sets
the value of repeat to 2 (streaming output), the character is sent immediately prior to
the streaming output that the unit will send. The OE command enables or disables
this character and its format is: OE(0 or 1), where 0 is disable and 1 is enable.
Example:
@123OE1
Acknowledge:
@ 123 RS232 EOT is on

Option Serial Command Source (OS)
The 9840 can take serial commands from both its USB port and its serial DB9 port via
RS232. This command allows the user to switch between those two methods
Example:
@123OS1
Acknowledge:
@ 123 Changing Communications Source to USB

Display Options Command (D)
The Display options command has 5 subcommands used to set options that effect the
front panel display of the Model 9840.

Display View Command (DV)
The Display View (DV) command is used to return the current values of all the display
options. The format is DV.
Example:
@123DV
Acknowledge:
@ 123 Filter is Type II Level 1
Filter Window A is Off
Filter Window B is On
Filter Window B = 0.0020
Filter Window C is Off
Filter Window D is Off
Channel A shows 5 decimal
Channel B shows 4 decimal
Channel C shows 5 decimal
Channel D shows 5 decimal
Channel A counts by 10
Channel B counts by 1
Channel C counts by 1
Channel D counts by 1
User sum 1: Disabled!
User sum 2: Disabled!
User sum 3: Disabled!
User sum 4: Disabled!
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Display Filter Command (DF)
The Display Filter (DF) command sets the filter type and level. The format is
DF(type)(level), where type is either 1 for type I filters, or 2 for type II filters, level must
be 1, 2, 3, or 4 depending on the level of filtering desired. (4 is most filtering and
slowest rise time).
Example:
@123DF13
Acknowledge:
@ 123 Filter is Type I Level 3

Display Decimal Command (DD)
The Display Decimal (DD) command sets the maximum number of decimal digits that
are shown for Load, Peak, and Valley. The format is DD(channel)(number), where
channel is A or B and the number must be between zero and 5.
Example:
@123DDA0
Acknowledge:
@ 123 Channel A shows 0 decimal digits

Display Position OPT Decimal Command (DP)
The Display Position Decimal (DP) command sets the maximum number of decimal
digits that are shown for the position. The format is DP(number). The number must
be between zero and 5.
Example:
@123DP4
Acknowledge:
@ 123 position shows 4 decimal digits

Display Count By Command (DC)
The Display Count by (DC) command sets the
smallest number that the display will count by
for the Load or Torq, Peak, and Valley
measurements. The format is
DC(channel)(code) where the code is selected
from the table at the right.
Example:
@123DCA3
Acknowledge:
@123 Channel A counts by 10
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1

2

2

5

3
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4
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Display Filter Window Commands (DW)
The Display Filter Window (DW) command set enables and disables the filter window
and allows the user to enter the unit and value of the filter window to use. There are
two commands used to enable and set the filter windows. The format to enable or
disable the Filter Window is DW1(channel)(0 or 1) where channel is A or B, 1 enables
the window and 0 disables the window. The format to set the window unit and value is
DW2(channel)(window unit)(window value)# where window unit is the desired unit for
the filtering window, and window value is the desired value of the window. The units
available will depend on the sensor that is currently active for the channel. It is a good
idea to issue the @123? command and find out what the active sensor is on the
channel with the @123SA or @123SB commands to make sure that the appropriate
unit will be entered. The window must be enabled before a value can be entered.
Disabling the window sets this value to 0. The window, once enabled and set, will take
effect immediately and will remain in effect until the window is disabled.
Note that changing a cell type on a channel will automatically disable the filter window
for that channel, reset the units to Lb or LbI, and set the window value to 0. The
window must then be reset and re-enabled by the user.
Example:
@123DW1A1
Acknowledge:
@ 123 Filter Window A is On
Example:
@123DW2A000.0002#
Acknowledge:
@ 123 Filter Window A Unit = Lb
@ 123 Filter Window A = 0.0002 Lb

Display User Sums (DS)
The Display User Sums (DS) command is used to enable/disable and set up to four
different possible User Sum combinations. The format is DS(sum index)(Ch. A) (Ch. B)
(Ch. C) (Ch. D), where sum index is 1, 2, 3 or 4 dependent on which sum the user wishes
to edit and the selections for channels are either a 0 (don’t add) or a 1 (add). Thus you
can add or remove any combination of these channels with a single command up to four
times.
Example:
@123DS20101
Acknowledge:
@ 123 User sum 2: B+D
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SYSTEM CALIBRATION MODE
The following procedure should be followed to calibrate the Model 9840 itself. This
calibration requires the use of a precision milli-volt per Volt reference which will be
attached on the load cell connector. The resulting scale factors are recorded in the nonvolatile memory of the Model 9840.

ATTENTION: System Calibration should ONLY be performed by trained, QUALIFIED
TECHNICIANS utilizing the proper precision devices to ensure the most accurate
performance of the unit.

1. To enter system calibration mode, go to the Main Menu. Using the num pad on the
right, enter the password “777”.
2. The unit will now enter a sub menu where you can select to calibrate an individual
channel or all four at once. At this point, it is ready to be calibrated. A two hour warmup period with the milli-volt per Volt reference attached is recommended at this time if
the unit has just been turned on or the milli-volt per Volt reference has just been
attached. Press any button to clear this display.
3. After selecting an option, you are now prompted to enter the first of three milli-volt per
Volt references. (We recommend using -3.0 milli-volt per Volt for the first and +3.0
milli-volt per Volt for the second. It requires 0.0 milli-volt per Volt for the third point.)
Set your reference and enter the appropriate number. As soon as you press “Enter”
the Model 9840 will start reading the reference.
4. Next you are prompted for the second milli-volt per Volt value. Set your reference and
enter the appropriate number. Again reading will start as soon as Enter is pressed.
5. When the read is complete, the unit will display the scale factors it generated.
Pressing the cancel button at this time will place the unit back to the main menu, and
pressing the back button will return you to the system calibration mode menu.
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APPENDIX A -- MODEL 9840 SPECIFICATIONS
Transducer Interface
Excitation

5VDC or 10 VDC software/auto selectable

Current Drive

180 mA at 5VDC or 10 VDC

Push Button Shunt

Yes

Internal Shunt Resistor

(2) Shunt values selectable, 30K ohms and 60K
ohms. Rear panel selectable

Calibration Method

Shunt, mV/V, Known Load

Push Button Tare

100% of range--display and analog output

Sensitivity Adjust

1mV/V to 4.5 mV/V

Accuracy

0.01% of full scale +/- 1 digital count

CMRR

115 dB

Additional Transducer Channel
Auxiliary Channel

optional

D/A Analog Output
Full Scale Output

+/- 10 VDC nominal +/- 0.5 VDC

Linearity

0.02 % of full scale

Scaling

Gain and offset selected by software.

Frequency Response

Approx. 15 Hz (plus filtering)

Output Source

Any displayed quantity

Output Channels

1 std, 2 optional

Direct Analog Output
Full Scale Output

-/+ 8.14 VDC +/- 0.25 VDC

Linearity

0.02 % of full scale

Scaling

Fixed with no tare, transducer channel only

Frequency Response

Approx. 1.5 kHz

Peak/Hold
Peak/Valley/Hold
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Digital I/O
Digital Inputs
Interface

4 optically isolated inputs

Function

remote tare, peak/valley reset, position reset, print

Digital Outputs
Function

4 independent limits

Quad-Limits Setup

Front panel, latching or non-latching set points
normally open/closed, enable/disable

Quad-Limits Output

4 isolated solid state switches

Quad-Limits Source

Any displayed quantity

Serial Interface
RS-232 Serial Setup/Output

Standard

RS-485 Serial Setup/Output

Standard

Multi-drop RS-232

Optional

USB

Standard

Printing

OPT

Optional

Interface Type

Serial

Quantities Printed

All displayed items

Encoder Position Channel

Optional

Encoder Type

Quadrature, 4X number of lines

Excitation

12 VDC std., 5 VDC optional

Interface

Single ended or differential

Calibration

User adjustable counts/inch

Auto Transducer Identification
Auto Identification and Setup

Yes, standard

Push Buttons
Smart Push Buttons

6

Adjustments

Displayed item, displayed units, tare, peak/valley
reset alternate view, print. Alternate functions for
programming.
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Digital Display
Display Characters

2 lines by 20 characters available

Display Update

> 4/Sec

Scaling

Automatic or manual

Maximum Display Count

± 999,999

Decimal Points. Selection

0 to 5 software selectable.

Display Type

Vacuum fluorescent

Resolution

24 bit

Software Filters

8, software selectable

Electrical Characteristics
Power Requirements

115 VAC, 60 Hz, Optional 230 VAC, 50 Hz

Fuse Requirements

115 VAC: Fuse, T, 0.315A, 250V
230 VAC: Fuse, T, 0.160A, 250V

Power Consumption

12 W (unloaded)

Transducer Excitation Current

Shutdown mode when shorted to ground

Absolute Max Transducer Input

30 VDC without damage

Physical Characteristics
Package Size

7.29” X 2.52 “ X 9.0” (W X H X D)

Case Material

Aluminum

Mounting Hardware

Available

Environmental
Operating Temp

0 C to 50 C

Storage Temp

-10 C to 60 C

Relative Humidity

95 % without condensation

The Model 9840 is
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APPENDIX B -- CABLES AND CONNECTORS
Load Cell Connectors

Pin
1
2
3
4
5
6
7
8
9

DB9 Female
Signal
EXCITE - HI
SENSE - HI1
CELL OUTPUT - HI
CELL OUTPUT - LO
SENSE - LO 1
EXCITE - LO
AUTO ID/TEDS OPT A
AUTO ID/TEDS OPT B
CHASSIS GND

Notes:
1. If the sense lines are not used, SENSE - HI must
be tied to EXCITE - HI and SENSE - LO must be
tied to EXCITE - LO.
2. Incorrect wiring of these ports can cause damage
to the internal circuitry of the unit. Please contact
Interface if you have questions or need assistance
with these configurations.

Serial Port Connector
DB 15 Male
Pin
Signal
1
TXD
2
RXD
3
No Connect
4
SERIAL GND
5
6
7
8
9
10
11-13
14
15
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Notes:
1. Pins 1 through 4 are used for RS232 ASCII
command set communications. Use 8 data bits, no
parity, 1 stop, and set the baud rate using the Com
baud rate entry on the System Options menu.
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Digital I/O Connector
Notes:
High Density 26 Female
Pin
Signal
1
1
LIM 1 A
2
LIM 1 B1
3
LIM 2 A
4
LIM 2 B
5
LIM 3 A
6
LIM 3 B
7
LIM 4 A
8
LIM 4 B
9
ISO IN 1 - HI2
10
ISO IN 1 - LO2
11
ISO IN 2 - HI
12
ISO IN 2 - LO
13
ISO IN 3 - HI
14
ISO IN 3 - LO
15
ISO IN 4 - HI
16
ISO IN 4 - LO
3
17
KEYLOCK
18
GND
19
ENCODER CHA-L4
20
ENCODER CHA
21
GND
22
ENCODER CHB-L
23
ENCODER CHB
24
GND
25
GND
26
+12 VDC
(+5 VDC optional4)
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1. Limits are optically isolated solid state switches
that can control AC or DC voltage. Peak blocking
voltage is 350V, maximum continuous current is 120
mA.
2. Digital inputs are opto-isolated with internal
current limiting resistors. Voltage range is +4 to +22
VDC on the “HI” input with respect to the “LO” input.
Other voltage ranges are possible with added
external resistors, contact Interface for details. If
isolation is not required these inputs may be
operated using the +12 VDC supplied on pin 26 and
the GND on pin 24.
3. The keylock input will be in the “unlocked” state if
left unconnected. Tie this pin to GND to “lock” it.
When locked the setup of the Model 9840 cannot be
changed (you cannot enter Setup mode).
4. The encoder inputs are intended for use with a
+12 VDC quadrature encoder. For single ended
signaling use the CHA and CHB pins, the CHA-L
and CHB-L pins are provided for differential signals.
The encoder can be supplied with the +12 VDC and
GND available on pins 26 and 24.
The Model 9840 will also accept +5 VDC encoder
inputs but these MUST be differential. Single ended
+5 VDC inputs are not supported on the standard
unit. Options for +5 VDC encoders are available.
Pin 26 will supply +5 VDC for this option and must
be ordered accordingly.
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OPTION ~ Remote Freeze Cable
P/N CABLE 988278-010
Remote Actuation Push-Button Display Hold/Freeze Cable
(Cable shown is approximately 10 feet)
The cable to support the digital input for display HOLD/FREEZE
actuation must connect to the 26 pin DIGITAL I/O connector
located on the rear panel of the Model 9840.
The connection is to actuate digital input #4, signals ISO IN
4 – HI (pin 15) and ISO IN 4 – LO (pin16).
To accomplish this, signal ISO IN 4 – LO (pin16) is tied to GND,
(pin 25).
A pushbutton switch is then installed across the signal ISO IN 4
– HI (pin 15) and the +12VDC (pin 26). In parallel with the
pushbutton switch, a .01uf ceramic capacitor is installed for
debouncing.
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High Density 26 Female
Pin Signal
1
1
LIM 1 A
2
LIM 1 B1
3
LIM 2 A
4
LIM 2 B
5
LIM 3 A
6
LIM 3 B
7
LIM 4 A
8
LIM 4 B
9
ISO IN 1 – HI2
10
ISO IN 1 – LO2
11
ISO IN 2 – HI
12
ISO IN 2 – LO
13
ISO IN 3 – HI
14
ISO IN 3 – LO
15
ISO IN 4 – HI
16
ISO IN 4 – LO
3
17
KEYLOCK
18
GND
19
ENCODER CHA-L4
20
ENCODER CHA
21
GND
22
ENCODER CHB-L
23
ENCODER CHB
24
GND
25
GND
26
+12 VDC
4
(+5 VDC optional )
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Digital I/O Connector
1. The source and scaling of ANALOG - OUT is selected through the menus.
2. The HIGH BANDWIDTH - OUT is a buffered analog output permanently connected
to the load cell channel.
3. If the 4-20 mA Option is purchased.

Pin
2
3
4
5
6
7
8
9

DB9 Male
Signal
ANALOG - OUT 1
ANALOG - GND
HIGH BANDWIDTH - OUT 2
CHANNEL A
4-20 mA – OUT 3
CHANNEL A
2nd ANALOG-OUT1
(Optional)
4-20 mA – OUT 3
CHANNEL B
HIGH BANDWIDTH - OUT 2
CHANNEL B
No Connect

USB Connector
Pin

Name

Description

1

VCC

+5 VDC

2

D-

Data –

3

D+

Data +

4

GND

Ground
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Precision Shunt Calibration Resistors
This diagram shows the connection of the precision internal shunt resistors.
The back panel switch (shown to the left of the two resistors) selects between 30 KΩ
and 60 KΩ.
The shunt check relay (shown to the right of the two resistors) connects the selected
resistor between the Excite High and the Cell Output High.

Sense High
Excite High
30 KΩ
60 KΩ
LOAD
CELL

Cell Output High

Excite Low
Sense Low
Cell Output Low
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